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About the iBrowser™ Data Integration Software User’s Guide
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❍ iBrowser Menus, page 5
❍ iBrowser Views, page 7
❍ Carrier Types and Carrier Numbering, page 7
❍ Copying and Saving Data, page 11
❍ Generating iBrowser Reports, page 13
❍ Defining iBrowser Groups, page 19
❍ About Batch Runs, page 26
❍ About Tissue Array Runs, page 32
❍ About Repetitive Scan Runs, page 32

❑ iBrowser Run Statistics View, page 34
❍ Summary Tab, page 34
❍ Summary Tab Sections, page 35
❍ Bar Graph Tab, page 39
❍ Statistics Scattergram Tab, page 40
❍ Carrier Map Table Tab, page 42

❑ iBrowser Carrier View, page 43
❍ Working with Single Images, page 43
❍ Well Images Tab, page 45
❍ Region Images Tab, page 46
❍ Field Images Tab, page 47
❍ Galleries Tab, page 48
❍ Scattergrams Tab, page 50
❍ Histograms Tab, page 52
❍ 2-Parameter Histograms Tab, page 56
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❍ KS Test Tab, page 62
❑ The iBrowser Report, page 66

❍ Introduction, page 66
❍ Well Selection, page 67
❍ Display Selection, page 68
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Introduction to iBrowser Data Integration Software
iBrowser™  Data Integration Software is an optional add-on product to the iCyte® 
Imaging Cytometer and iCys™ Research Imaging Cytometer, both from CompuCyte 
Corporation, that allows you to examine and compare data generated by iCyte or iCys. 
For detailed information about iCyte and iCys, including a glossary of terms, see your 
iCyte Imaging Cytometer User Guide or iCys Research Imaging Cytometer User 
Guide.

About iBrowser
The iCyte Imaging Cytometer and iCys Research Imaging Cytometer generate 
cytometric data and images from samples in a variety of carriers, including 96-well 
plates, microscope slides, petri dishes, and chamber slides. When setting up an 
analysis in either iCyte or iCys, you determine the kind of data collection you want for 
the run. Within iBrowser, depending on the output data you selected in iCyte or iCys, 
you can display a report that contains any combination of:

❑ Galleries of cells

❑ Run Statistics

❑ Histograms

❑ Scan images

❑ Scattergrams

❑ 2-Parameter Histograms

For every scanning run, the Imaging Cytometer generates and saves a Run.xml file 
that contains the metadata created for that run. Descriptions of the types of data you 
can generate can be found in your iCyte Imaging Cytometer User Guide or iCys 
Research Imaging Cytometer User Guide. The data available in a run file depends on 
the features selected at the time the sample was scanned. A run can also be generated 
by “re-scanning” the raw data of an existing run.

In addition to displaying data generated from the Imaging Cytometer, the iBrowser 
provides additional analysis capabilities such as the Kolmogorov-Smirnov (KS) Test.

Note: The iCyte Imaging Cytometer allows for the use of batch (multiple 
carrier) runs. Within iBrowser, there are a number of features that are 
specific to batch runs. If your site is using iCys, or iCyte without the 
optional robot, the batch features will not apply.
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Starting iBrowser

To launch iBrowser, click on the iBrowser icon  on your desktop, or start 
iBrowser.exe.The iBrowser opens an empty Summary View:

Figure 1: An Empty iBrowser Summary View

Opening a Run

1. Select File ⇒ Open

2. The Open Run dialog displays the contents of the Data Cyte folder, the data 
storage location on the instrument.

Alternatively, you can click on "Custom" to choose runs from a custom folder 
(such a network archive or CD) or "Recent" to choose from the runs recently 
opened in iCyte.

If your run is in none of these predefined groups, you can always select Browse 
and locate the run.xml file yourself.

3. When a run is selected, it's key properties such as Annotation, Creation Date, Data 
format, and Path are displayed

4. Press OK to open the selected run.
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iBrowser Menus
The iBrowser has the following menus:

❑ File

❑ Setup

❑ View

❑ Help

The menus are described briefly in this section.

File Menu
❑ Open—Allows you to open an existing Run as described in “Opening a Run” on 

page 4. If you open another Run while a previous Run open, iBrowser closes the 
previous run.

iBrowser defaults to the last opened Run.

❑ Report Annotation—Allows you to add or change the annotation for a report. 
For information about changing the annotation, see “Adding To or Changing 
Report Annotations” on page 18. 

❑ Save Report as Image—Allows you to save the output of the current tab to an 
image file. You can select from the following filetypes:
❍ .jpg (JPEG, the default)
❍ .bmp (Bitmap image)
❍ .tif (TIFF image)

Tip: To save single images from a tab, right-click the mouse with your cursor 
in the image you want and select Save As. 

❑ Preview Report—Displays information that will be printed as an iBrowser 
report. Generating reports is discussed in “Generating iBrowser Reports” on 
page 13.
❍ From the Run Statistics and Carrier View tabs, iBrowser allows you to 

generate an iBrowser report, which displays all the images for that tab 
available from the current run. 

❍ From the Report tab, iBrowser displays the iBrowser Report, which contains 
detailed images from a single well within your run. The Report is discussed in 
detail in “The iBrowser Report” on page 66.

❑ Print Report—Allows you to send the current report either to a printer or to a 
PDF file. Printing reports is described in detail in “Generating iBrowser Reports” 
on page 13. 

❑ Exit—Closes iBrowser.
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Setup Menu
❑ Groups—Allows you to specify groups of wells or scan areas. For information 

about creating groups, see “Defining iBrowser Groups” on page 19.

View Menu
❑ Show All Carriers or Show All Wells—Depending on the type of run, either 

Show All Carriers or Show All Wells will be available from the View menu.

Show All Carriers and Show All Wells allow you to switch between the current 
carrier or well and all available carriers or wells. When Show All... is selected, the 
view of the Scanned Wells graphic and all accompanying data change, as follows: 
❍ Show All Carriers—For batch runs (that are not tissue array runs), you can 

select Show All Carriers to display the scanned wells and statistics for every 
carrier in the run. When Show All Carriers is selected, the tabs in the Carrier 
View also show images for each carrier in the run, as described in “About 
Batch Runs” on page 26. 

Show All Carriers is only available for batch runs created using the optional 
robot feature on iCyte. If the currently open run consists of a single carrier 
(and is not a tissue array run), Show All Carriers will be greyed-out and 
unavailable. Because the robot is not supported for iCys, Show All Carriers 
will always be greyed out. For more information, see “About Batch Runs” on 
page 26.

❍ Show All Wells—If the run is a tissue array run, and there are multiple wells 
(that is, multiple scan areas defined in the carrier), you can select Show All 
Wells to display the scan areas and statistics for every well in the run.  

Show All Wells is only available from the View Menu if you have generated a 
tissue array scan using the iNovator Array Alignment module. If your site 
does not use the iNovator Application Development Toolkit to generate tissue 
arrays, Show All Wells does not apply. 

Help Menu
❑ iBrowser User Guide—Opens the iBrowser User Guide in Adobe Acrobat-

readable format.

❑ Depending on the application you have installed, there will be a link to one of the 
following documents:
❍ iCyte User Guide—Opens the iCyte Imaging Cytometer User Guide in 

Adobe Acrobat-readable format.
❍ iCys User Guide—Opens iCys Research Imaging Cytometer User Guide in 

Adobe Acrobat-readable format.

❑ CompuCyte on the Web—If you have access to the Internet, opens the 
CompuCyte website at www.compucyte.com.

❑ About iBrowser—Displays information about this release of iBrowser.

www.compucyte.com
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iBrowser Views
The iBrowser has three primary views:

❑ The Run Statistics view, shown in Figure 1, “An Empty iBrowser Summary 
View,” on page 4, displays various views of the available Statistics (that is, 
information and graphics about all of the wells or scan fields on one or more 
carriers), as well as a summary of the data from the scanned wells. The features in 
the Run Statistics view are discussed beginning on page 34.   

❑ The Carrier View displays images and other data about every well or scan area in 
a carrier for which data is available. Each tab in the Carrier view is arranged in a 
carrier-like grid to allow you to compare the wells in a carrier against one another. 
The Carrier View is discussed in “iBrowser Carrier View” on page 43.

❑ The Report View allows you to generate a report featuring detailed information 
about a single well or scan area. The Report is discussed in “The iBrowser 
Report” on page 66.   

Carrier Types and Carrier Numbering
iBrowser retrieves information directly from a Run. Therefore, when you open a Run 
in iBrowser, the carrier display is based on the type of carrier and Run that was used 
for the iCyte or iCys Run with which the data was acquired. 

General Case Carrier Numbering 
In general, a run uses a single carrier and does not contain a tissue array. This section 
describes the carriers used by iCyte and iCys and their numbering schemes in these 
cases. 

However, your site may either support the optional robot for batch processing (iCyte 
only) or use the optional iNovator Application Development Toolkit to process tissue 
arrays. The numbering schemes for these cases are discussed in “Carrier Numbering 
for Batch, Tissue Array, and Two-Scale Runs” on page 8. 

The following types of carriers are currently supported:

❑ Microtiter Plates—iCyte and iCys support microtiter plates with 6, 12, 24, 48, 
96, and 384 wells. Microtiter plates (are sometimes referred to as “plates” or 
“microplates”).

Microplates are always numbered using letters row letters and column numbers. 
For example:
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Each well in the plate is referred to by its letter and number, such as A1 or E6. 

❑ Slides and other carriers
❍ Standard slides—Slides are used for both tissue and cellular samples. A 

standard single slide is numbered by scan area. In keeping with the Room 
analogy used for 4-slide carriers (discussed below), a standard slide is always 
labeled as “R1” for Room 1. For example, the Scanned Wells display for a 
single slide with three scan areas:

❍ 4-slide carriers—To make scanning slides more efficient, CompuCyte has 
developed a 4-slide carrier that fits on a standard microscope stage. The 
carrier's rooms are in this case slides, labeled R1 to R4. Slides are used for 
both tissue and cellular samples.

Note: The 4-slide carrier holds slides upside down. Therefore, within iCyte and 
iCys, the slides are numbered from right to left.

Petri dishes and chamber slides—To widen the array of samples that can be scanned 
with iCyte and iCys, CompuCyte has developed holders for petri dishes and chamber 
slides that fit on a standard microscope stage.

The petri dish holder allows you to scan up to 3 petri dishes at a time. Each dish is a 
room, and, in the case of cell colonies or other samples, each room can have multiple 
scan areas (like the 4-slide carrier, above). Unlike the 4-slide carrier, a petri dish 
holder will have at most 3 rooms.

Chamber slides are available in a variety of configurations; containing between one 
and eight rooms. Like the 4-slide carrier, each room is assigned a room number and 
each room can have multiple scan areas.

In addition, your site may have custom carriers. Generally, these will follow the same 
numbering scheme as slides and other carriers.

Carrier Numbering for Batch, Tissue Array, and Two-Scale Runs
Batch and tissue array runs are special cases that use optional features. Batch runs 
require running iCyte with an optional robot. Tissue array runs use the iNovator Array 
Alignment module to scan multiple small tissue cores on a slide; often using a 4-slide 
carrier. The numbering schemes for each of these is described below. 
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❑ Batch runs—For batch runs, iBrowser shows the carrier number and well or scan 
area name. iBrowser adds the carrier number to the beginning of the well or scan 
area number. Therefore, Cr3-A12 is well A12 on Carrier 3 and Cr5-R1-3 is Room 
1, Scan Area 3 in Carrier 5. For more information about working with batch runs, 
see “About Batch Runs” on page 26.

❑ Tissue array runs—For tissue array runs, iBrowser displays the room number 
and the tissue array number. Tissue arrays are numbered by X position and Y 
position: 1,1; 1,2; 2,1 and so on. For example:

❑ Batch Tissue Runs—For a batch tissue array run, without Show All Wells 
selected, you can select both the Carrier and the Well from the pulldown, as 
follows:

When Show All Wells is selected, tissue cores are displayed by well. In the 
following example, the carrier, room, and well number are shown on the left; the 
tissue core number of each well is displayed on the top. The gray squares indicate 
areas where no data is available.

In the above example, two carriers are shown. For each carrier, Rooms 1 and 2 are 
shown as processed, Room 1 containing 3 wells, and Room 2 containing 4 wells.

❑ Two-Scale runs—For runs using scout scans and field scans, iBrowser shows the 
scout scan number, the dynamic scan area number, and the room number. 
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Therefore, 1-2-R3 is Room 3, Scout scan area number 1, Dynamic scan area 
number 2. For example:

In the above example, Room 1 contains 4 scout scan areas, while Room 2 contains 
3 scout scan areas.  Where both boxes are colored green in a row, both rooms 
contain that scout scan area and dynamic scan area.  In the case of Room 1 Scout 
scan area number 4, there are 4 Dynamic scan areas, while Room 2 Scout scan 
area number 4 contains only 2 Dynamic scan areas.  In the case of Room 1 Scout 
scan area number 2, there are 2 scan areas, while for Room 2 Scout scan area 
number 2, there are 4 Dynamic scan areas.

❑ Two-Scale Scanning with Batch Analysis—When Two-Scale scanning is 
combined with Batch analysis, iBrowser adds the Room number to the beginning 
of the Scout scan area/Dynamic scan area number, and displays these entries as 
column headings.  Carrier numbers are displayed as row headings.  For example:

This example shows a Batch run using 2 carriers, with Rooms 1 and 2 containing 
Scout scan areas.  Carrier 1 Room 1 contains 3 Scout scan areas-the first Scout 
scan area contains 2 Dynamic scan areas, the second contains 1 Dynamic scan 
area, and the third contains 3 Dynamic scan areas.



Revision B iBrowser User’s Guide  11

March 29, 2005 iBrowser™ Data Integration Software User’s Guide

The carriers (including defining custom carriers) and iNovator are described in detail 
in the iCyte Imaging Cytometer User Guide or iCys Research Imaging Cytometer 
User Guide. The optional robot is described in the iCyte Imaging Cytometer User 
Guide.

Copying and Saving Data
While being able to see all of the images in a carrier is extremely useful, there may be 
times when you want to focus on single images for publications. Using iBrowser, you 
can export single images from any iBrowser window. All iBrowser images and tabular 
data can be copied to the clipboard or saved in an appropriate format.

Note: The save or copy attributes for a type of image are the same in both their 
appropriate tabs and when displayed in the Report View. 

Copying Images and Tables to the Clipboard
You can copy the images in iBrowser to any application that supports pasting of 
bitmaps (such as Microsoft Word, Microsoft Excel, WordPad, or Paintshop Pro).

➣ To copy an image:

1. Place your cursor on the image that you want to copy to the clipboard. 

You can copy well images, scan images, galleries, histograms, scattergrams, 2-
parameter histograms, the Run Statistics, Bar Graph and the Statistics 
Scattergram.

2. Right-click the mouse. The Copy command displays. 

3. Click Copy. Images are copied to the clipboard and can be pasted (using the Paste 
command) into any application that supports bitmap pasting.

Copying Tabular Data to the Clipboard
The data from the Run Statistics and Carrier Map tables is copied as tab-delimited 
text. This allows you to paste them into applications such as Microsoft Word or Excel.

➣ To copy tabular data:

1. Place your cursor on the table that you want to copy to the clipboard. 

2. Right-click the mouse. The Copy command displays. 

3. Click Copy. The data from the table is copied to the clipboard as tab-delimited 
text and can be pasted (using the Paste command) into any application that 
supports text pasting.
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Tip: To generate custom graphs or statistical analyses, you may want to copy 
Run Statistics to Excel. 

Saving Images and Tables
From iBrowser, you can save images and tabular data in an appropriate format, as 
follows:

❑ Each of the elements in the Carrier View can be saved as a file in one of the 
following formats:
❍ JPEG (*.jpg)
❍ Bitmap (*.bmp)
❍ TIFF (*.tif)

❑ The Run Statistics Bar Graph and Statistics Scattergram are saved as Bitmap 
(*.bmp) files.

❑ The Run Statistics table and Carrier Map table are saved as a tab-delimited text 
(*.txt) files. 

➣ To save an image or table:

1. Place your cursor on the image that you want to save. 

2. Right-click the mouse. The Save As command displays. Select Save As.

3. The Save As window displays, prompting you to save the image or tabular data in 
a file in the last directory used.

4. If desired, save the file to a new location, and enter a name for this file.

The file will be saved with the name and location you select.
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Generating iBrowser Reports
iBrowser presents the data generated from iCyte and iCys in an easily understandable 
format. To allow you to save that data, you can easily generate a report from any 
iBrowser tab. All iBrowser reports contain the following information:

❑ Header information regarding the experiment, including:
❍ The name of the currently displayed tab (such as Run Statistics Bar Graph or 

Well Images. 
❍ The Run number and name of this run.
❍ Any pertinent information about the images displayed (such as Channel or 

Region).
❍ The report annotation (as described in “Adding To or Changing Report 

Annotations” on page 18).
❍ The date this report is generated.

❑ The images from the currently displayed tab (with the current settings).

Selecting the Report Output Mode
When you generate a reports, you need to select the output mode:

❑ On your computer screen

❑ To a printer

❑ To a PDF file, if your site has Adobe Acrobat 6.0 or 7.0 installed

❑ As an image (in Bitmap, JPEG, or TIFF format) 

Each of these is discussed below.

Note: Reports from the Report tab contain the identical information and are 
generated the same way. However, they are set up to display detailed 
information from a singe well or scan area. For information about 
creating Reports, see “The iBrowser Report” on page 66.

Generating a Screen, Printer, or PDF Report
Using the Preview Report and Print Report commands, you can generate a paginated 
report for any iBrowser tab and send it to your screen, directly to a printer, or to a PDF 
(Portable Document Format) file. 

➣ To generate an iBrowser screen or printer report:

1. Select the tab for which you want to create an iBrowser report.

Note: Reports from the Summary tab display only the Run Statistics table.
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2. When you are happy with the data you have selected, select File ⇒ Preview 
Report to display the report on your screen. For example:

3. If desired, you can make changes to your view of the iBrowser Report using the 
Preview Report toolbar:

From the toolbar you can:
❍ Print the iBrowser Report
❍ Zoom the preview in or out anywhere between 10% and 500%. 
❍ Select how many pages you want to see in the Preview Report window.
❍ Close the Preview and return to iBrowser.

4. When you are ready to print the report, select File ⇒ Print Report. The Print 
window displays:
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5.  The default printer is always displayed in the Name field. From here, you can:

❍ Send your report to a physical printer: 

a. Make sure the printer Name is set to the name of your printer. 

b. When you click OK, the report is sent to the physical printer. 

❍ If your site has Adobe Acrobat installed, you can send your report to a PDF 
file:

a. Make sure the printer Name is set to the name is set to Adobe PDF, 

b. When you click OK, the report is converted to PDF and sent to the My 
Documents folder on your desktop. 

The Adobe PDF printer should have the correct settings. However, if you 
need to make changes to these settings, see the Installation Guide for iCyte or 
iCys for more information. For detailed information about using Adobe 
Acrobat, see the Acrobat Online Help. 

 Creating Multiple Page PDF Reports
With Adobe Acrobat, you can easily create multi-page reports that allow you to, for 
example, display the same elements in a Report for each well or scan area in a Run. 

➣ To generate a multiple page report:

1. Follow the directions for creating a PDF report in “Generating a Screen, Printer, 
or PDF Report” on page 13. Generating the first PDF report opens Adobe 
Acrobat. 

2. Change the input as desired (for example, you may want to select a different well 
in a Report, as described in “The iBrowser Report” on page 66), and generate 
another PDF report. Each additional report is saved as a separate file and opened 
in Acrobat. 

3. When you have generated all the single reports that you want to include in your 
multiple page report, switch to Adobe Acrobat.

4. From the Acrobat menu bar, select Create PDF ⇒ From Multiple Files. The 
Create PDF from Multiple Documents window displays:
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5. Make sure “Include all open PDF documents” is checked. 

6. Any documents that are already open are displayed in the Files to Combine 
window. If you are creating the multiple page report immediately after generating 
the reports from iBrowser, this list may contain all the files you want.

From this window your can:
❍ Add files to the Files to Combine list—Click the Browse button and browse 

to the files you want to include in this report.
❍ Remove unneeded files from the list—Select a file and click Remove. 
❍ Rearrange files—Select a file and click Move Up or Move Down. 

7. When you have the complete list of files for your report, click OK. 

8. Acrobat combines the reports into a single file named Binderx.pdf (where x is an 
incremental number for the multiple document files). You can save your new 
report under this name, or select File ⇒ Save As and give your report a more 
meaningful name. Additionally, you can choose to:

❍ Print your new report—Select File ⇒ Print to send your report to the 
default printer.

❍ Email your new report—Select File ⇒ Send by Email for Review. Follow 
the directions or see the Adobe Acrobat online help for information.

Note: Any user with Acrobat Reader can view iBrowser PDF reports. Acrobat 
Reader is available for free from the Adobe website. 

http://www.adobe.com/products/acrobat/readstep2.html
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9. When you are done, close Acrobat. 

Generating a Report Image
While screen and printer reports allow you to display your data, these reports can only 
be saved to a PDF file. To save a report directly use the Save Report as Image 
command. 

➣ To generate an image report:

1. Select the tab for which you want to create an iBrowser Report.

Note: The Report from the Summary tab displays only the Run Statistics table.

2. When you are happy with the data you have selected, select File ⇒ Save Report 
as Image.

3. The Save As window displays. Select the name and location for this report. By 
default, iBrowser names it with the Run number, tab name, and any pertinent 
information (such as Channel or Region). 

4. Select the type of image: Bitmap, JPEG or TIFF. The image types are briefly 
described in “Saving Images and Tables” on page 12. Note that, because the 
image is saved with the screen resolution, it will show less detail than other 
reports generated in iBrowser. 

5. Click OK.

6. Your report is saved in the same format as your current iBrowser view. For 
example:
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Adding To or Changing Report Annotations
By default, iBrowser reports use the Run annotation that was created when the Run 
was generated in iCyte or iCys. Under some circumstances, however, you may want to 
either add information to the annotation or replace it with information that reflects a 
specific iBrowser report.   

➣ To add to or change the report annotation:

1. Select File ⇒ Report Annotation. The Report Annotation window displays with 
the current Run annotation:
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2. Make the changes you want to the annotation and click OK. The report annotation 
is changed and will display on any reports you create during this iBrowser 
session. 

Note: Report annotations are only saved for the duration of an iBrowser session. 
They are not permanently stored. 

Defining iBrowser Groups
iBrowser allows you to create related groups of wells or scan areas using the Groups 
command in the Setup menu. You can use the Define Groups feature to either assign 

wells to the default “Control” group, or to create your own groups. When you assign a 
well to a group, the color of the well changes to reflect its new group.

Why Create Groups?
Groups allow you to display aggregate information about multiple wells. When you 
create a group, either Control or User-defined, iBrowser displays the mean and 
standard deviation for every well feature in the group at the bottom of the iBrowser 
Run Statistics window. Additionally, you can display the combined data for a group in 
a histogram or 2-parameter histogram. 

For batch runs, the statistics are displayed for each carrier as well as for all the carriers 
in the run.

There are two kinds of groups:

❑ Control Groups—A control group is a set of one or more wells for which the 
data is averaged and then compared against other wells in the carrier. The KS test 
requires control groups. 

Defining Control groups is described in “Assigning Wells to a Control Group” on 
page 20

❑ User-defined Groups—A user-defined group is a group for which you select the 
wells, the name, and even the color. You may, for example, want to create groups 
to differentiate between wells treated with different compounds or to group the 
control wells for your experiment (which may be different than the control wells 
you want for the KS test).

Defining other groups is described in “Creating a User-Defined Group” on 
page 22.
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Assigning Wells to a Control Group
➣ To assign wells to the Control group:

1. Select Groups from the Setup menu. The Groups window displays:

2. Highlight Control from the Groups window and click Edit. The Set Control Wells 
window displays. The wells that contain iBrowser data are shown in green.

Note: The Batch Handling section of the window is grayed out and unavailable 
unless you are working with a batch run. See “Creating Groups for Batch 
Runs” on page 28 for more information.

3. Click on the wells that you want as the controls. The wells will turn blue as you 
select them. For example, in the following figure, the first row has been selected 
as the control row:
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4. Optionally, select the method you want to use to apply the controls:

❍ Apply to whole carrier—In this case, all of the control wells in the carrier 
are averaged, and the averaged data is compared to every non-control well in 
the carrier. This is the default.

❍ Apply per row—For each row, all of the control wells are averaged. Then, 
every non-control well in the row will be compared against the averaged 
control well data for that row.

❍ Apply per column—For each column, all of the control wells are averaged. 
Then, every non-control well in the column will be compared against the 
averaged control well data for that column.

5. Optionally, you can change the color of wells in the Control group. Changing the 
color is described in “Changing or Setting the Group Color” on page 25. 

6. When you have selected the wells, and any options, you want for the Control 
group, click OK on the Set Control Wells window and Close on the Groups 
window.

7. When you look at Run Statistics summary (on the Summary tab of the Carrier 
View), the Control wells are noted in the Group column and Control statistics 
display at the bottom of the Run Statistics summary window:



iBrowser™ Data Integration Software User’s Guide Introduction to iBrowser Data Integration Software

22  iBrowser User’s Guide Revision B

Creating a User-Defined Group
Creating a user-defined group is different for batch runs. For information, see 
“Creating Groups for Batch Runs” on page 28.

➣ To create a user-defined group:

1. Select Groups from the Setup menu. The Groups window displays:

2. Click New. The New Group window displays. Note that the Control group (blue 
wells) is still shown.
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You can change the following information:
❍ By default, the name of the first group is Group1. If desired, enter a new name 

in the Name box.
❍ iBrowser provides a default color for each group. However, you can change 

the color by clicking Custom. For more information, see “Changing or Setting 
the Group Color” on page 25.

❍ If this run is a batch run (created using iCyte with an optional robot), the 
Batch Handling section will be available. Otherwise it is grayed out and 
unavailable. For information about the creating groups for batch runs, see 
“Creating Groups for Batch Runs” on page 28.

3. Click on the wells that you want as the controls. Each well will turn the color you 
specified (in the Color window, described in “Changing or Setting the Group 
Color” on page 25) as you select it. For example, in the following figure, the first 
column remains selected as the controls, and the second column is a new group 
(called Group 1):
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4. When you have selected the wells, and new name or color (if desired), for the new 
group, click OK on the New Group window and Close on the Groups window.

5. When you look at the Run Statistics summary (on the Summary tab of the Carrier 
View), the wells in the new group are noted in the Group column and group 
statistics display at the bottom of the Run Statistics summary window:

The group statistics include:
❍ Group Mean—Arithmetic mean of the feature values for the group
❍ Group StdDev—Standard deviation of the feature values for the group.
❍ Group Sum—Sum of the feature values for the group.



Revision B iBrowser User’s Guide  25

March 29, 2005 iBrowser™ Data Integration Software User’s Guide

Changing or Setting the Group Color
If desired, you can choose the color you want for the wells in a group. You can either 
select from the basic colors or create your own color.

➣  To change the well color for a group:

1. From the New Group or Edit Group window, click Custom. The Basic Colors 
window displays:

2. From this window you can do one of the following:

❍ Select an existing custom color. Click OK to close the color window and 
Apply or OK to save your selection.

❍ Click Define Custom Colors. The full Color window displays:

Define the color you want using your cursor in the color window, the hue and 
intensity, or the RGB settings. When you are happy with the color, click Add 
to Custom Color. 

The color will display in a Custom colors box. Select the color and click OK. 
Then click Apply or OK to save your selection. Then new color will be the 
color of the group.
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About Batch Runs
If you have generated runs that use multiple carriers (a feature that is available using 
iCyte with an optional robot as described in the iCyte Imaging Cytometer User 
Guide), there are a few differences in iBrowser behavior.

Batch Numbering
For batch runs, iBrowser adds the carrier number to the beginning of the well or scan 
area number. Therefore, Cr3-A12 is well A12 on Carrier 3 and Cr5-R1-3 is Room 1, 
Scan Area 3 in Carrier 5.

Showing All Carriers for Batch Runs
For batch runs, you can select View ⇒ Show All Carriers from the menu bar.

If, for example you have a Run containing a number of 4-slide carriers, and the single 
carrier view is as follows:

Then, when you select Show All Carriers, the new view will be as follows:

For a batch Tissue Array Run (as described in the “Scanned Wells Section” on 
page 35), then the numbering will follow through from the tissue array.
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Viewing Run Statistics Across All Carriers
For batch runs in which you chose Same selection for all carriers in the Batch 
Handling section (described in “Creating Groups for Batch Runs” on page 28), the 
groups you select on one carrier are applied to every carrier in the run.

When you look at the Run Statistics summary (on the Carrier Map Table tab of the 
Run Statistics View), the wells in the new group are noted in the Group column and 
group statistics display at the bottom of the Run Statistics summary window. When 
you select Show All Carriers, iBrowser also includes the statistics for each group 
across all carriers.

For example:
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Carrier Views Across All Carriers
When you show all carriers, the images in the remaining Carrier View tabs are shown 
in the same format as above. For these carriers, the Histograms tab appears as follows:

If there are more images than can fit in a single window, a scroll bar at the bottom, or 
to the right, of this window appears to enable you to scroll through all the scan images.

Viewing the Bar Graph for All Carriers
When Show All Carriers is selected, all wells or scan areas are shown in the Bar 
Graph. Each scan area number includes the carrier number:

Creating Groups for Batch Runs
For batch runs, for each group, you can select whether you want to:

❑ Have each group be identical across all the carriers in the group.

❑ Individually select the wells on each carrier for the group.
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➣ To create a batch control group:

1. Select Groups from the Setup menu. The Groups window displays:

2. Select Control from the Groups window and then click Edit. The Control Group 
window displays. 

You can change the following information:
❍ Batch Handling Section—Allows you to determine how to handle groups for 

each carrier. You can select to have groups apply:

— Same selection for all carriers

—Individual selection per carrier
❍ Apply Controls—Allows you to select how to apply the control wells as 

described in “Assigning Wells to a Control Group” on page 20.
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❍ iBrowser provides a default color for each group. However, you can change 
the color by clicking Custom. For more information, see “Changing or Setting 
the Group Color” on page 25.

3. If you select:

❍  Same selection for all carriers, the process is similar to that for a single 
carrier run as described in “Assigning Wells to a Control Group” on page 20.

❍ If you select Individual selection per carrier, the view in the Set Control 
Wells changes to display all wells for each carrier in the run, as follows:

Click on the wells that you want as the controls. 

4. When you have selected the wells, and a new color (if desired), for the Control 
group, click OK on the Set Control Wells window and Close on the Groups 
window.

5. When you look at the Run Statistics summary (on the Summary tab of the Carrier 
View), the wells in the Control group are noted in the Group column and group 
statistics display at the bottom of the Run Statistics summary window.
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Creating a Batch Group
Creating a batch group is like creating a single carrier group except, as for the batch 
control group, you can elect whether you want to select wells across all carriers or for 
individual carriers. 

For example:

When you look at the Run Statistics summary (on the Summary tab of the Carrier 
View), the wells in the new group are noted in the Group column and group statistics 
display at the bottom of the Run Statistics summary window.

For example:
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About Tissue Array Runs
Tissue arrays are slides with many small cores of tissue and are numbered by row and 
column. Tissue arrays should be scanned utilizing the Array Alignment module of the 
iNovator Application Development Toolkit. iBrowser will then display the cores in an 
array layout similar to a microplate. However, one well will be displayed at a glance, 
rather than an entire carrier. 

About Repetitive Scan Runs
Repetitive scans allow you to take multiple scans of the same scan area and observe 
changes over time. iBrowser allows viewing statistics and images for each cycle.

In the examples below a Bar Graph is shown for cycle 2 (started 10 minutes after 
cycle 1) and for all cycles.



Revision B iBrowser User’s Guide  33

March 29, 2005 iBrowser™ Data Integration Software User’s Guide

For more information about repetitive scans, see your iCys or iCyte User Guide.
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iBrowser Run Statistics View
The iBrowser Run Statistics view contains a number of tabs, each of which provide a 
different view of the data from an iCyte or iCys Run. This section discusses each tab 
in the Run Statistics, as follows:

❑ Summary Tab, page 34

❑ Bar Graph Tab, page 39

❑ Carrier Map Table Tab, page 42

❑ Statistics Scattergram Tab, page 40

Summary Tab
The first step in using iBrowser is to open a Run as described in “Opening a Run” on 
page 4. When you open a Run, the Run Statistics page opens with the Summary tab 
active, and displays information about the run you selected, as shown in Figure 2, 
below.

Figure 2: The iBrowser Run Statisitics with Data
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Summary Tab Sections
The Summary Tab is divided into three main sections:

❑ Scanned Wells Section, page 35

❑ Run Information Section, page 37

❑ Run Statistics Section, page 37

Scanned Wells Section
The Scanned Wells graphic at the upper left of the page indicates the wells or scan 
areas for which there is data. If no groups are selected, the scanned wells are green. 

The way scanned wells are displayed and labeled depends on the type of carrier:

❍ Microplates—Microplates are labeled by row letter and column number. The 
top left well is A1, for a 96-well plate, the bottom right well is H12. The row 
letters and column numbers are displayed as shown in Figure 3.

Figure 3: Sample Microplate Well Labeling

❍ Tissue Arrays—Tissue arrays can be generated from iCyte or iCys only  
using the iNovator Array Alignment module. Tissue arrays are slides with 
many small cores of tissue and are numbered by X position and Y position; 
the top right tissue core is labeled 1,1, the next core in the first row is 2,1, and 
so on.
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Figure 4 shows the Carrier View Summary of a tissue array along with the 
scout scan view of the same array.

Figure 4: Sample Tissue Array Labeling

For more information about tissue array runs, see “About Tissue Array Runs” 
on page 32. 

Other carriers—For all non-plate carriers, such as slides, petri dishes, and 
chamber slides, the scan areas are laid out by “rooms”. A room is a separate 
container within each carrier, such as one petri dish in a 3-petri dish carrier or a 
single slide within a 4-slide carrier.

For example, Figure 5 shows a 4-slide carrier, in which each slide is a room. the 
first three slides have two scan areas, and the fourth slide has three scan areas.

For single slides, the room number is always 1.

Additionally, as shown in Figure 5, for batch runs, a Carrier drop-down list is 
available to select the carrier you want to view.

Figure 5: Sample 4-Slide Carrier Labeling

Tissue Array
Carrier Display

       Well Image

Carrier Display
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Note: Note: The 4-slide carrier holds slides upside down. Therefore, within 
iCyte and iCys, the carriers are numbered from right to left.

Run Information Section
General information about the Run is displayed in the upper right of the screen.This 
includes:

❑ The Run Number

❑ The Run Name

❑ The instrument the run was created on

❑ The date of the run

❑ Any annotation entered at the time of the run

❑ The carrier type used for this run

Run Statistics Section
Run Statistics information is displayed at the bottom of the window. The information 
displayed is based on the Run Statistics defined in iCyte or iCys before the data was 
scanned.

An example of a partial Run Statistics display is shown below.

Carrier 1
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Figure 6: Sample Run Statistics Data

Tabs
A tab will be available for each component for which statistics have been setup. In this 
example, the Well tab show a row for each well; the Primary tab shows a row for each 
Primary event.

Columns
There are typically four sets of columns:

❑ Row Number (#)—A sequential number for the row, useful to return to the 
original sort order.

❑ Row Identification—(Carrier, Room, Well, <Parent Component Name>, 
<Component Name>)

At the minimum there will be a <Component Name> column (such as Well or 
Primary), to identify the item on the row. Additional columns such as Carrier, 
Room, <Parent Component Name> will be displayed if needed.

❑ Group—the group the row belongs to. For single-scale run shown for the Well 
tab, for two-scale run shown for the scan area event component (such as Tissue)

❑ Statistics—one column for each run statistic defined in iCyte or iCys.

Group Statistics
When groups are defined, rows for the Group Mean, Group StdDev, and Group Sum 
will be added at the bottom.

Sorting the Data
The data in the Statistics window can be listed in either increasing or decreasing order 
by any column. To change the order of the data, click on the column name on which 
you want to sort. Click once to change the order of the data to descending; click a 
second time to reverse the order. To return to the original sort order, click on the # 
column.
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Bar Graph Tab
The Bar Graph tab provides a way to display one statistic for many wells. Use the 
Component and Statistics pulldowns to choose the parameter you wish to view. The 
available options reflect the statistics saved at the time of data acquisition.

Figure 7: Bar Graph Tab

Selecting Your View
You can select the data you want to view in the graph:

❑ Carrier—For batch runs, you can select the carrier for which you want to view 
the statistics.

For a single carrier run, the Carrier pulldown is greyed out and unavailable.

❑ Cycle—For repetitive scans, you can select the cycle for which you want to view 
the statistics. You can also select all cycles.

For a non-repetitive scans, the Cycle pulldown is greyed out and unavailable.

❑ Component—Select the component (or well) for which you want to choose the 
statistics. 

❑ Statistic—Select the Statistic of the selected component. You can select from any 
statistic that was generated at the time the data was acquired in iCyte or iCys.
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Viewing Individual Well or Scan Area Data
To view the data from an individual well or scan area, place your cursor over a bar. As 
you run the cursor over the graph, the data for each individual well or scan area 
displays.

If you have defined groups, the group data is also available.

Copying and Saving the Run Statistics Graph
You can copy or save the Run Statistics graph by right-clicking on the graph as 
described in “Copying and Saving Data” on page 11. The graph can only be saved as 
in bitmap (.bmp) format.

Statistics Scattergram Tab
The Statistics Scattergram tab provides a way to plot two statistics for many wells. 
Use the Component and Statistics pulldowns to choose the parameter you wish to 
view. The available options reflect the statistics saved at the time of data acquisition.

Each point on the graph represents the data from an individual well.
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Selecting Your View
You can select the data you want to view in the graph:

❑ Carrier—For batch runs, you can select the carrier for which you want to view 
the statistics.

For a single carrier run, the Carrier pulldown is greyed out and unavailable.

❑ Cycle—For repetitive scans, you can select the cycle for which you want to view 
the statistics. You can also select all cycles.

For a non-repetitive scans, the Cycle pulldown is greyed out and unavailable.

❑ Component—Select the component (or well) for which you want to choose the 
statistics. 

❑ X Statistic and Y Statistic—Select the Statistic of the selected component. You 
can select from any statistic that was generated at the time the data was acquired 
in iCyte or iCys.

Copying and Saving the Statistics Scattergram
You can copy or save the Statistics Scattergram by right-clicking on the graph as 
described in “Copying and Saving Data” on page 11. 
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Carrier Map Table Tab
The Carrier Map Table tab displays the numeric data from all available statistics for 
this Run. Use the Component and Statistics pulldowns to choose the parameter you 
wish to view. The available options reflect the statistics saved at the time of data 
acquisition.

Figure 8: Carrier Map Table Tab

Selecting Your View
You can select the data you want to view in the Carrier Map Table:

❑ Carrier—For batch runs, you can select the carrier for which you want to view 
the statistics.

For a single carrier run, the Carrier pulldown is greyed out and unavailable.

❑ Cycle—For repetitive scans, you can select the cycle for which you want to view 
the statistics.

For a non-repetitive scans, the Cycle pulldown is greyed out and unavailable.

❑ Component—The component for which the data can be laid out in a grid. It is 
displayed for informational purpose only and cannot be changed. For single-scale 
the component will be the Well, for two-scale run the component will be the scan 
area event component (such as Tissue).

❑ Statistic—Select the Statistic of the selected component. You can select from any 
statistic that was generated at the time the data was acquired in iCyte or iCys.

Copying and Saving the Carrier Map Table
You can copy or save the Carrier Map Table by right-clicking on the table, as 
described in “Copying and Saving Data” on page 11. The data in the table is copied or 
saved as tab-delimited text (.txt) format, which allows you to easily open it in a 
spreadsheet program such as Excel.
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iBrowser Carrier View
The iBrowser Carrier View contains a number of tabs, each of which provide a 
different view of the data from an iCyte or iCys Run. 

Introduction
This section discusses each tab in the Carrier View, as follows:

❑ Well Images Tab, page 45

❑ Region Images Tab, page 46

❑ Field Images Tab, page 47

❑ Galleries Tab, page 48

❑ Scattergrams Tab, page 50

❑ Histograms Tab, page 52

❑ 2-Parameter Histograms Tab, page 56

❑ KS Test Tab, page 62

Working with Single Images
For each tab in the Carrier View, you can view the data for every scan area or well in 
the carrier. Additionally, you can obtain a better view of a feature for a single well or 
scan area by double-clicking on an image within one of the Carrier View tabs. 

The image you see depends on the tab, as follows:

❑ Well Images, Region Images and Field Images—When you double-click on a 
single image, the image displays in full (100%) resolution. For example:
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❑ Galleries—The gallery view, as described in “Galleries Tab” on page 48, displays 
only the first image in each gallery. when you double-click on an image, the entire 
gallery with which that image is associated displays. For example:

  

❑ Scattergrams and Histograms—For scattergrams and histograms, including 2-
parameter and KS histograms, when you double-click on any image, the image 
displays in full (100%) resolution with its axis and scale information. For 
example:

     

Changing the Image Size
You can change the size of any single image (or gallery) by using your cursor to grab 
the right-hand corner of the image.
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Copying and Saving Images
As described in “Copying and Saving Data” on page 11, you can copy and save any 
images from the Carrier View.

➣ To copy or save a single image, you can either right-click on the image within the 
selected tab or first double-click on the image (to make it larger or provide details such 
about axis and scale) and then right-click on the image.

➣ To copy or save an entire set of images, select File ⇒ Preview Report. iBrowser will 
generate a report that contains all the images in the selected tab. For more information, 
see “Generating iBrowser Reports” on page 13. 

Well Images Tab
The Well Images tab displays, for each well or scan area, a mosaic of all scan fields in 
the well.

Figure 9: Well Images Tab

Tip: Double-click on any well image to display a full size image of that well.

Use the pulldown windows at the bottom left of the Well Images tab to specify the 
images you want to display:

❑ Carrier—For batch runs, you can select the carrier for which you want to view 
the images. 

For a single carrier run, the Carrier pulldown is grayed out and unavailable.
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❑ Cycle—For repetitive scans, you can select the cycle for which you want to view 
the images. 

For a non-repetitive scans, the Cycle pulldown is grayed out and unavailable.

❑ Channel—Allows you to select the channel you want displayed in the images.

❑ Show Contours—For two-scale runs, allows you show the scan area event 
contours in each well image. This allows you to locate the region used for data 
acquisition in the well.

For single-scale runs, the Show Contours checkbox is grayed out.

Region Images Tab
Region Images are only available for two-scale scans. The Region Images tab 
displays, for each scan area event, mosaics of all scan fields scanned in the second 
scale.

Figure 10: Region Images Tab

Tip: Double-click on any region image to display a full size image of that 
region.

Use the pulldown windows at the bottom left of the Region Images tab to specify the 
data you want to display:

❑ Carrier—For batch runs, you can select the carrier for which you want to view 
the images. 

For a single carrier run, the Carrier pulldown is grayed out and unavailable.
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❑ Cycle—For repetitive scans, you can select the cycle for which you want to view 
the images. 

For a non-repetitive scans, the Cycle pulldown is grayed out and unavailable.

❑ Channel—Allows you to select the channel you want displayed in the images.

Field Images Tab
The Field Images tab displays a scan field of the scan area for the well or scan area. 
For example:

Figure 11: Field Images Tab

Tip: Double-click on any field image to display a full size image of that field.

Use the pulldown windows at the bottom left of the Field Images tab to specify the 
data you want to display:

❑ Carrier—For batch runs, you can select the carrier for which you want to view 
the images. For a single carrier run, the Carrier pulldown is grayed out and 
unavailable.

❑ Cycle—For repetitive scans, you can select the cycle for which you want to view 
the images. For a non-repetitive scans, the Cycle pulldown is grayed out and 
unavailable.
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❑ Channel—Allows you to select the channel you want displayed in the images.

❑ Scan Field—Use the Scan Field pull-down to select the scan field that you want 
view from the Field Images tab.

Tip: You can use the up and down arrow keys to scroll through the scan field 
images

Galleries Tab
This tab allows you to display gallery images saved at the time of data acquisition, as 
shown below. In the Carrier view the gallery will display the first gallery image from 
each well in the carrier.

Figure 12: Galleries Tab

Use the pulldown windows at the bottom left of the Galleries tab to specify the data 
you want to display:

❑ Carrier—For batch runs, you can select the carrier you want to display. For a 
single carrier run, the Carrier pulldown is grayed out and unavailable.

❑ Cycle—For repetitive scans, you can select the cycle you want to display. For a 
non-repetitive scans, the Cycle pulldown is grayed out and unavailable.

❑ Channel—Select the channel you wish to see displayed in the gallery

❑ Region—Select the region you want to view. A region is a user-defined bounded 
area on a scattergram or histogram that isolates a subpopulation of events.
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For example, the following scattergram has a single region that encompasses most 
of the events in this scan field:

The region must have been created at the time the data was acquired. Regions 
cannot be modified in iBrowser.

To display the entire gallery for the selected channel and region in a single well, 
double click on that well, for example:
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Scattergrams Tab
The Scattergrams tab allows you to view the output from any scattergrams that were 
saved at the time of data acquisition. Scattergrams in iBrowser are defined by the 
scattergrams in an iCyte or iCys Run. 

The Scattergrams tab displays one scattergram for each well or scan area in the carrier:

Figure 13: Scattergrams Tab

Use the pulldown windows at the bottom left of the Scattergram tab to specify the data 
you want to display:

❑ Carrier—For batch runs, you can select the carrier you want to display. If the run 
consists of a single carrier, the number in the carrier window defaults to 1 and is 
grayed out.

❑ Scattergram—Click on the scattergram pulldown window at the bottom left 
corner of the scattergram tab. The names of the scattergrams generated for this 
Run display.

Select one of the available scattergram names. iBrowser displays the available 
scattergrams. Selecting a different scattergram name will change the displayed 
scattergrams.
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Right-click on the Scattergrams tab to display the following menu: 

 

From this menu you can select:

❑ Show Regions—If the scattergrams were generated with regions, Show Regions 
will be available. Click Show Regions to display any regions that were available 
during this Run. For example:

 

The regions will display until you clear the checkmark from Show Regions. 

Note: Scattergrams display in the manner in which they were generated. In the 
example above, a white background was selected for this scattergram in 
iCyte or iCys. 

❑ Copy—Allows you to copy a Scattergram as described in “Copying and Saving 
Data” on page 11. 

❑ Save As—Allows you to save a copy of a Scattergram as described in “Copying 
and Saving Data” on page 11. 
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Histograms Tab
The Histograms tab allows you to view the output from any histograms that were 
saved at the time of data acquisition. Histograms in iBrowser are defined by the 
histograms in an iCyte or iCys Run. Colors are based on regions brought forward from 
when the histograms were generated (in iCyte or iCys).

The Histograms tab displays one histogram for each well or scan area in the carrier. To 
make histograms easier to view, they always display with a white background.

Figure 14: Histograms Tab

Histogram Options

Selecting a Histogram
To select the histograms you want to view:

1. For batch runs, select the carrier you want to display. If the run consists of a single 
carrier, the number in the carrier window defaults to 1 and is grayed out.

2. Click on the histogram pulldown window at the bottom left corner of the 
histogram tab. The names of the histograms generated for this Run display.
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3. Select one of the available histogram names. iBrowser displays the available 
histograms. Selecting a different histogram name will change the displayed 
histograms.

Selecting the Outline Mode
Next to the histogram menu is an outline checkbox. Click the Outline checkbox to 
display the histograms in outline format: 

The Histogram Graph Scale
At the bottom right of the Histogram tab is the Graph section which displays the 
minimum and maximum limits of the histogram axes along with the axis titles. To 
allow you to easily compare a set of histograms, the Y axis scale is set to the 
maximum Y value of the currently shown set of histograms. Then all histograms are 
normalized to that scale to simplify comparison.

Histogram Right-Click Options
If you right-click on a histogram within the Histogram tab, the following menu 
displays:

From this menu you can:

❑ Show Statistics—If you click on Show Statistics, a line is drawn down the center 
of each histogram and iBrowser displays the percentage of data on each side of the 
line. For example:
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If you place the cursor on the histogram line in any histogram, the cursor will turn 
into a two-headed arrow and you can use it to move the dividing line. As you 
move it, the statistics change accordingly. For example:

You can turn statistics off by clearing the checkmark from the Show Statistics 
menu selection or by selecting Show Regions.

❑ Apply Statistics Globally— When statistics are selected, you can select Apply 
Statistics Globally from the menu. Then, any change you make to the location of 
the dividing line for any histogram is made globally for all histograms in the tab. 
For example, after changing the histogram above, Apply Statistics Globally was 
set for the tab:
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If you turn Show Statistics off, Apply Statistics Globally remains selected. The 
next time you turn Show Statistics on, they will still be globally selected until you 
turn Apply Statistics Globally off. 

❑ Show Regions—If the histograms were generated with regions, Show Regions 
will be available (unless Show Statistics is selected). For example:

 

The regions will display until you clear the checkmark from Show Regions or 
select Show Statistics. 

Note: You can toggle between Show Statistics and Show Regions. When one is 
selected, the other is always off. 

❑ Copy—Allows you to copy a Histogram as described in “Copying and Saving 
Data” on page 11. 

❑ Save As—Allows you to save a copy of a Histogram as described in “Copying 
and Saving Data” on page 11. 
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2-Parameter Histograms Tab
In iCyte and iCys, you can generate 2-Parameter Histogram Density or Expression 
Maps (set from the Scattergram Graph Property window, described in the iCyte 
Imaging Cytometer User Guide or iCys Research Imaging Cytometer User Guide. 
iBrowser generates 3-dimensional plots (where a color scale represents the Z-axis), 
for each well or scan area scanned. The following is an example of the 2-Parameter 
Histogram tab: 

Figure 15: 2-Parameter Histograms Tab

At the bottom of the histogram page is the Graph section which displays the minimum 
and maximum limits of the histogram axes along with the axis titles. To allow you to 
easily compare a set of 2-parameter histograms, the Z color scale is set to the 
maximum Z value of the currently shown set of 2-parameter histograms. Then all of 
the 2-parameter histograms in this set are normalized to that scale to simplify 
comparison.

Note that each histogram definition (S1, S2, and so on) has its own color scale. 

Selecting a 2-Parameter Histogram
To select the histograms you want to view:

1. For batch runs, select the carrier you want to display. If the run consists of a single 
carrier, the number in the carrier window defaults to 1 and is grayed out.

2. Click on the histogram pulldown window at the bottom left corner of the 
histogram tab. The names of the histograms generated for this Run display.
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3. Select one of the available histogram names. iBrowser displays the available 
histograms. Selecting a different histogram name will change the displayed 
histograms.

Setting the Colors and Color Scale
While you cannot change the minimum and maximum limits for 2-parameter 
histograms, you can change the colors and the color scale for the Z axis. 

Tip: If you place the cursor over the color scale on either the 2-Parameter 
Histogram tab or in the Set Color Dialog window, the values for the 
selected color display as a tooltip.

About the Set Color Dialog Window
When you double-click on the color bar in the 2-Parameter Histogram Tab, the Set 
Color Dialog displays:

The Set Color Dialog displays the following information:

❑  The current color scale. 

❑ The upper value associated with each color.

❑ Color boxes, from which you can change the colors, as described in “Changing 
the Colors” on page 59.

❑ Data: Min and Max—The minimum and maximum data points for all the 
histograms currently displayed. 

❑ Reset Scale—Allows you to reset the scale as follows: 
❍ z Value Equalization— Sets the color scale such that the distance between 

two consecutive points is constant (that is, Scale = (Zmax - Zmin) / n). Z 
value equalization is the default scale used when a Run is initially opened. 

❍ Histogram Equalization—Sets the color scale such that each color 
represents the same number of pixels. 

The following images show the difference between Z Value and Histogram 
Equalization: 
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To change the scale from z Value to Histogram Equalization (or back), select 
the scale you want and click Reset and then click Apply or OK. Note that 
when you change the color scale, you will lose any changes you made. 

❑ Apply—Apply changes to the color scale without closing.

❑ OK—Apply changes to the color scale and then close the window.

❑ Cancel—Close without saving your changes. 

Changing the Color Scale
You may want to change the color scale to, for example, use the same scale across a 
series of 2-parameter histograms with different parameters or to make some colors 
stand out within the histogram. 

➣ To change the color scale:

1. Double-click on the color line in the lower-right of the 2-Parameter Histogram 
tab. The Set Color Dialog displays. Enter new scale values in the white boxes. 

If you try to enter an invalid number, an error icon displays: 

Tip: Place the tip of your cursor over the exclamation point to display a tooltip 
message containing the expected values. 

2. When you have set the values, click Apply on the Set Color Dialog window. The 
images in the 2-Parameter Histogram tab will change to reflect the new scale. 

3. If you are happy with the new scale, click OK to close the Set Color Dialog 
window. To go back to the original color scheme, click Reset Scale and z Value 
Equalization.

Z Value Equalization Histogram Equalization
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Changing the Colors
➣ To change the color for a particular scale:

1. Double-click on the color line in the lower-right of the 2-Parameter Histogram 
tab. The Set Color Dialog displays.

2. Click on one of the colored boxes. The Color window displays:

3. Select a new color and click OK. The color changes for the selected box and its 
scale graphic in the Set Color Dialog window. To select custom colors, see the 
instructions under “Changing or Setting the Group Color” on page 25. 

4. From the Set Color Dialog window, click Apply. The images in the 2-Parameter 
Histogram tab will reflect the new color. In Figure 16, for example, the dark blue 
on the color scale has been changed to magenta and magenta has been changed to 
black. This allows you to better view the lighter blue pixels within the graph. 

Figure 16: Changing the Color Scale

5. If you are happy with the new color, click OK to close the Set Color Dialog 
window. To go back to the original color scheme, click Default.



iBrowser™ Data Integration Software User’s Guide iBrowser Carrier View

60  iBrowser User’s Guide Revision B

2-Parameter Histogram Right-Click Options
If you right-click on a 2-parameter histogram within the 2-Parameter Histogram tab, 
the following menu displays:

Note: Show Statistics is available only for Density maps. For Expression maps, 
Show Statistics is greyed out and unavailable. 

From this menu you can:

❑ Show Statistics—For Density 2-parameter histograms only, click on Show 
Statistics. Lines drawn down the centers of each histogram display the percentage 
of data in each quarter. For example:

At this point, you can place the cursor in any histogram. If you place the cursor on 
the histogram line in any histogram, the cursor will turn into a two-headed arrow 
and you can use it to move the dividing line. As you move it, the statistics and bin 
number change accordingly. For example:

You can turn off the statistics by clearing the checkmark from the Show Statistics 
menu selection.

❑ Apply Statistics Globally— When statistics are selected, Alternatively, you can 
right-click again and select Apply Statistics Globally from the menu. Then, any 
change you make to the dividing line for any histogram is made globally for all 
histograms in the tab, as shown. For example:
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You can turn off the statistics by clearing the checkmark from the Statistics menu 
selection. If you turn Show Statistics off, Apply Statistics Globally remains 
selected. The next time you turn Show Statistics on, they will still be globally 
selected until you turn Apply Statistics Globally off. 

❑ Show Regions—If the 2-parameter histograms were generated with regions, 
Show Regions will be available. For example:

 

The regions will display until you clear the checkmark from Show Regions or 
select Show Statistics. 

Note: Regions and statistics cannot be displayed at the same time. If, for 
example, Show Regions is selected and you select Show Statistics, the 
statistics will display but regions will be cleared.   

❑ Copy—Allows you to copy a 2-Parameter Histogram as described in “Copying 
and Saving Data” on page 11. 

❑ Save As—Allows you to save a copy of a 2-Parameter Histogram as descr3ibed in 
“Copying and Saving Data” on page 11. 
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KS Test Tab
The KS (Kolmogorov-Smirnov) test assesses the statistical difference between a given 
set of histograms.

The following describes the steps involved in performing a KS test.

Setting up the KS Test
When you click the KS Test tab, a series of histograms will appear, one for each well 
that was scanned. Before running the KS Test, you need to perform some setup steps. 

To set up the KS Test:

1. For batch runs, select the carrier you want to display. If the run consists of a single 
carrier, the number in the carrier window defaults to 1 and is grayed out.

2. Select the parameter you wish to analyze from the Histogram pull-down menu.

3. Choose the control wells as described in “Assigning Wells to a Control Group” on 
page 20.

Running the KS Test
The KS Step pulldown window at the bottom of the page allows you to see the data at 
different steps in the KS test process.These steps are explained below.
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1. Original Data

Display the original histograms to be processed, as follows:

Note: In this example, all wells in column 12 have been set as controls.

2. Count Normalized Data

Normalize the data in all wells to 5000 events. This, essentially, makes the area 
under each of the histograms identical, allowing consistent comparison with data 
from the control wells and the other wells in the carrier.This can be seen in the 
following figure.

3. Data Integral

Display the integrated data from each histogram. The KS software scans each 
histogram from left to right and sums the data as it does so. The results are plotted 
as data integral histograms, seen below.
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4. Averaged, Normalized Controls

Display a series of histograms which represent the control against which the data 
from each well will be compared.The values vary depending on the type of 
control wells you selected, as follows: 
❍ Applied to whole carrier—The values of all control wells are averaged and 

the histograms are identical.
❍ Applied per row —The values of the controls in each row are averaged.
❍ Applied per column —The values of the controls in each column are 

averaged.

5. Control Integral

Display a series of identical histograms representing the integral of the averaged 
normalized control.The values vary depending on the type of control wells you 
selected, as follows: 
❍ Applied to whole carrier—The values of all control wells are averaged and 

the histograms are identical.
❍ Applied per row —The values of the controls in each row are averaged. The 

histograms for each row will be identical; however, the rows will differ from 
one another.
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❍ Applied per column —The values of the controls in each column are 
averaged. The histograms for each column will be identical; however, the 
columns will differ from one another.

The following example shows the controls applied per row. Note that the values in 
each row are identical.

6. Difference of Integrals

Displays a series of plots representing the control integral subtracted from each of 
the well integrals. These plots graphically illustrate where the differences lie 
between each well in the carrier and the controls.

In this example, you can see that the drug response is very high in the first few 
columns, and becomes lower as you move towards the control well (in column 12) 
Note that because column 12 is the control for each row, there is no difference in 
the data, hence the KS-Test value is 0.
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The iBrowser Report

Introduction
The Report section of iBrowser allows you to create reports on a well-by-well basis. 
Click on the Report tab to open the Report window as shown in Figure 17.

Note: After you print or save a Report, keep in mind that you can select a new 
well with the same display options and print (or save) the new well in a 
new Report.

Figure 17:  Report Window

The Report window displays the following:
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❑ Well selection

❑ Display selection

❑ Report pane

Each of these is discussed in detail below.

Well Selection
The Well Selection graphic indicates which wells in the carrier were scanned for data. 

Keep in mind the following:

❑ Scanned wells are colored green by default, though the color of some or all wells 
may reflect groups. 

❑ When you select a well, the selected well displays as white. If you click Select 
Group, all wells in the group display as white.

❑ You can choose to display the averages for histograms and 2-parameter 
histograms by clicking Select Group. 
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Display Selection
The display selection section allows you add images to the report pane.

Managing Your Images

Selecting a Well
To display a well image, region image, field image, gallery, histogram, or 2-parameter 
histogram on the Report, you must first select a well (or group of wells) in one of the 
following ways:

❑ Click on the well in the Well Selection graphic

❑ Click on the bar representing the well in the bar graph.

❑ After clicking on Select Group, click on a single well that is part of a previously 
defined group. The entire group will be selected (and appear white). 

Note: Selecting a group is useful only for displaying the averaged well data for 
histograms and 2-parameter histograms. 

The selected well (or group of wells) appears white in the Well Selection graphic.

Creating Multiple Images
As you start to generate images, they collect on the Report. 

When you select a new well, the data in the Report is updated to reflect the originally 
selected image-type and parameters for the newly selected well. You can use this 
feature to, for example, create a series of images for one well using a number of 
different channels.

Images stay on the Report until they are cleared or you exit iBrowser.

Deleting Single Images
To remove a single image from the Report, right-click on the image and select Delete. 
The image is removed from the report. 

Clearing the Report
If the Report window becomes too cluttered, click the Delete All Images button, 
located at the bottom, to remove all images currently displayed in the Report.

Displaying Statistics in the Report
You can turn statistics on and off for histograms, 2-parameter Density histograms, and 
the KS test in the Report by right-clicking and selecting Statistics. You can turn 
statistics on or off and move the line for each individual image in your report. As you 
move the line, the percentages change to reflect the new line location.

For example:
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For more information about displaying histogram statistics, see “Histogram Options” 
on page 52.

Displaying Well Images
Select Well Image to display a well image of a specific channel for the selected well.

➣ To display a Well Image:

1. Choose a channel from the Channel pull-down menu:

2. For two-scale runs, you can select Show Contours of the scan area events in the 
image.

3. Click Display. The well image of that parameter for the selected well displays in 
the Report.
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If, for a two-scale run, Show Contours has been checked, the selected scan area 
will be highlighted in the image. If the contours are hard to see, double-click to 
enlarge the image.

Displaying Region Images
For two-scale runs, select Region Image to display a region image of a specific 
channel for a selected well.

➣ To display a Region Image:

1. Choose a channel from the Channel pull-down menu:

2. Click Display. The region image of that channel for the selected region displays in 
the Report.
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Displaying Field Images
Select Field Image to display field images of a specified channel for a selected well.

➣ To display a scan image:

1. Choose a channel, and if desired, a Scan Field from the Field Images pull-down 
menus:

2. Click Display to display the scan image for the selected well and parameters in the 
Report.

Displaying Galleries
Select Gallery to display gallery views of individual wells. (Galleries created from the 
Carrier View window display events from each scanned well in the carrier)
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➣ To display a Gallery view:

1. Select the channel and region from the Gallery pull down menus.

Note that the region must have been created at the time of data acquisition.

2. Click Display to display the gallery in the Report.

Displaying Scattergrams
Select Scattergram to create a scattergram of that parameter for the selected well.

➣ To display a scattergram: 

1. Select a well and a scattergram parameter:

2. Click Display to display the scattergram in the Report. 
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3. If a scattergram has regions, you can show the regions by right-clicking on the 
scattergram image and selecting Show Regions. The regions will display for the 
selected image. For example:

 

Displaying Histograms
Select Histogram to display a histogram of that parameter for the selected well.

You can generate a histogram for the average of a group of wells by clicking Select 
Group at the top of the Well Selection graphic and then selecting one well in a 
previously specified group (as described in “Defining iBrowser Groups” on page 19.

➣ To display a histogram:

1. Select a well and a histogram parameter:

2. Click Display to display the histogram for the selected well and parameters in the 
Report.
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3. If a histogram has regions, you can show the regions by right-clicking on the 
histogram image and selecting Show Regions. The regions will display for the 
selected image. For example: 

4. If desired, you can view the statistics for a histogram by right-clicking on the 
histogram image and select Show Statistics.

Displaying 2-Parameter Histograms
Select 2-Parameter Histogram to display a 2-parameter histogram of that parameter 
for the selected well. 2-parameter histograms are created in the General tab in the 
Scattergrams Properties window) in iCyte and iCys.

Note: You can generate a 2-parameter histogram for the average of a group of 
wells by clicking Select Group at the top of the Well Selection graphic 
and then selecting one well in a previously specified group (as described 
in “Defining iBrowser Groups” on page 19.

To display a 2-parameter histogram:

1. Select a well and a 2-parameter histogram parameter:
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Tip: Unless 2-parameter histograms are explicitly titled (from the Scattergram 
Properties menu in iCyte or iCys), density maps are titled Density and 
Expression maps are titled with the name of the selected expression. 

2. Click Display to display the 2-parameter histogram for the selected well and 
parameters in the Report. iBrowser displays the 2-parameter histogram with any 
saved changes to the color scale in the 2-Parameter Histogram tab (as described in 
“2-Parameter Histograms Tab” on page 56). 

Any changes you made to the color scale in the 2-Parameter Histogram tab are 
carried forward and will appear in the Report. 

Printing or Saving Reports 
You can save or print reports from the Report in the same manner as any other 
iBrowser reports. Printing and saving reports is described in “Generating iBrowser 

Reports” on page 13. 
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